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The GuidosToolbox (Graphical User Interface for the Description of image 
Objects and their Shapes) provides generic image processing tools.  
 

All tools are based on geometric concepts only and  
can thus be applied to any kind of raster data. 

 
This document describes the various menus and features of GuidosToolbox:  
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The system requirements are a PC or a Mac with at least 2 GB of system 
memory, the more the better. This application has been tested on a variety of 
current Linux distributions, Intel-Mac® OS X 10.11, and Microsoft Windows® 
XP SP3 – Windows 10 platforms. The latest version of this application, 
including manual and installation instructions, can be obtained from the 
GuidosToolbox homepage. 

 

 
 
 
 
Citation reference for GuidosToolbox: 
Vogt P, 2016. GuidosToolbox (Graphical User Interface for the Description of 
image Objects and their Shapes): Digital image analysis software collection 
available at: http://forest.jrc.ec.europa.eu/download/software/guidos 
 
If you use MSPA in your work then please add the following reference: 
Soille P, Vogt P, 2008. Morphological segmentation of binary patterns. Pattern 
Recognition Letters 30, 4:456-459, DOI: 10.1016/j.patrec.2008.10.015 
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http://dx.doi.org/10.1016/j.patrec.2008.10.015
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Windows and menus 
The following graphical elements can be used to interact with GuidosToolbox: 
 

 a horizontal menu bar (top panel) 
 a window to set different attributes of the image and its graphical 

display (top left panel) 
 a window to set MSPA parameters and statistics (bottom left panel) 
 a viewport (right panel) 
 a window for image coordinates & values (bottom right panel) 

 

1. The menu bar of GuidosToolbox 
The top menu bar offers 4 pull-down menus: 
 

 File 
 General Tools 
 Image Analysis 
 Help 

 

1.1. The File pull-down menu  

The File pull-down menu offers the following options: 
 

 Read Image 
 Save Image 
 Batch Process 
 Exit 

 

1.1.1 Read image 

This menu is used to read your input data: 
 

 GeoTiff:  The default image type is GeoTiff (a “.tif”-formatted file 
having information on projection, etc.). GeoTiff can be read or pre/post-
processed by any image processing (IP) or GIS software. 
 

 Generic: image of formats like tif, png, bmp, jpeg, etc. 
 

 IP Software: IP software (ESRI, ARC, IDRISI, etc.) raster image 
formats like img, bil, etc. The included Gdal will try to convert these 
formats into GeoTiff. Alternatively, go back into your IP software and 
export the image to GeoTiff.  
 

 ENVI: an image from an ENVI session (extension “.hdr”). 
GuidosToolbox will not use the geo-information of the ENVI-data.  If 
you want to maintain the geo-information you should export the data in 
ENVI to GeoTiff and read this format in GuidosToolbox.  
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1.1.2 Save Image 

This menu is used to save your processed data. The options are similar as in 
the Read menu. Additional options are: 
 

 Display Snapshot: will save a snapshot of the current viewport in 
GuidosToolbox. This option may be suitable when working with a large 
image and a quick-look of the processed image is sufficient. In case of 
saving a MSPA result, the filenames will include the settings of the 4 
MSPA parameters. If MSPA statistics were enabled, an additional file 
containing these statistics will be saved with the same notation and the 
additional suffix '_stat.txt'. 
                      

 KML: export to kml-format for visualization in Google Earth, requiring 
an image in the projection EPSG:4326 (WGS 84). To re-project either 
use reproject to GoogleEarth or start the GDAL Terminal and use the 
command gdalwarp and the appropriate EPSG reference codes. The 
result is stored in a zip-archive. Extract this archive at any location and 
load the included kml-file into Google Earth. When exporting a MSPA 
image, a customized header plus MSPA legend is added automatically.  

 
The default data directory is the subdirectory 'data' located in the main 
GuidosToolbox directory. 
Note: Please use the default GeoTiff format for maximum compatibility.  
 

1.1.3 Batch Process 

This option allows automatic processing of multiple files in batch mode. Input 
files must be in the default format (Geo-)Tiff. GuidosToolbox will save the 
output files in (Geo-)Tiff format to the same location of the input images. The 
default data directory is the subdirectory 'data' located in the main 
GuidosToolbox directory but you can use any other directory as well. 
 
 Conefor Inputs: this option will generate the node file and the distance 

(connection) file in the format required by Conefor. The input file can be 
either a single image or a set of images with a background value of zero in 
a variety of raster image formats. The distances can be calculated as 
Euclidean edge-to-edge distance (8/4-connected) or centroid distance 
between all foreground objects of the raster image.  

 
 
 
 
 
 
 

 

Figure 1: Conefor Inputs: select 8/4-connectivity and distance measures 

 

http://www.gdal.org/gdalwarp.html
http://spatialreference.org/ref/epsg/
http://www.conefor.org/
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The output is saved into the input data directory and contains the log-file 
'ConeforInputs.log'; the node and distance file; and in case of centroid 
distance a dendrogram file for each valid input image.  
Note: when using the option Conefor Inputs the connectivity is defined 
via the pairwise distance between image objects. This is different to the 
option MSPA Conefor Inputs, where the connectivity is defined via the 
MSPA-detected structural connectors (bridges). 

 
 Euclidean Distance: batch-process images for Euclidean Distance 

maps and a summary of the distance histogram properties. 
 
 MSPA: this option will open a window to select the MSPA parameters and 

a switch for statistical output. The resulting filenames will include the 
settings of the 4 MSPA parameters and, if selected, separate statistics. 

 
 MSPA Tiling: this option will perform a MSPA-analysis with an automated 

buffered tiling of a single image which is larger than the standard 
maximum file-size (MS-Windows: 100002 pixels; Linux/Mac OS X: larger 
than 100002 pixels, depending on the available free RAM). After verifying 
MSPA-compliance a window will open where the MSPA parameters can 
be specified. No statistics will be calculated for these large images. 

 
 Moving Window: this menu provides options for batch processing of 

several moving window algorithms. The dimension of the moving window 
can be specified via a popup window (Figure 3). 

 
 Fragmentation: this menu provides several options for batch processing. 

More information on the individual options is available in the respective 
sections in this manual. 
 

 Recode: first, select a sample image to set up the recoding table. Next, 
select a series of images to which this recoding table should be applied. 

  

1.1.4 Exit 

Quit the program and return to the operating system. 
 
 

1.2. The General Tools pull-down menu  

The General Tools pull-down menu provides generic image processing 
utilities, which may be useful for a variety of purposes.  The following options 
are available: 
 

 Preprocessing 

 Convolution 

 Equalization 
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 Thresholding 

 Edge Enhance 

 Morphological 

 GIS Software 

 Original Image 

 Undo/Redo 

1.2.1 Preprocessing 

The Preprocessing menu provides several generic image-processing routines 
targeted to reassign image pixel values. These routines can also be used for 
setting up MSPA-compliant input images. The following options are available: 
 
 Convert → Byte: convert your data to the data type Byte. 

 
 RGB → Single Band: convert RGB-image to single-band image. 

 
 Reproject for GoogleEarth: if the geo-header information of the currently 

loaded GeoTiff file has a EPSG code different to 4326 then this option can 
be used to reproject the image to EPSG:4326 (WGS 84). 
 

 Recode: a table showing new and current unique pixel values is 
displayed. The new value entries in the left column can be reassigned to 
match the desired recoding of image class values. The Save button can be 
used to save a new recode table to a file GTrecode.sav. Any previously 
saved recoding table can be restored via the Restore button. Here, only 
those entries that match the current class values will be restored. This 
option is only available for images of data type Byte. Please note that you 
have to press the Enter key to get a new value accepted in the table. 
 

 Cost Marker Image: this menu allows defining a marker image for the 
Cost analysis (p. 25). Instructions to mark start/target objects as points or 
polygons as well as missing data are provided via popup windows.  
 

 Threshold: FG/BG: apply a threshold to a gray-scale image to obtain a 
binary image with foreground and background (FG/BG). 
 

 Group: FG/BG/Missing: group a sequence of gray-scale image values 
into FG/BG/Missing. 
 

 X → FG/BG/Missing: assign an individual gray-scale pixel value to 
FG/BG/Missing. 
 

 Invert: exchange the current assignment of FG/BG/Missing. 
 

 Add 1b: add 1 byte to all current image values. 
 

 Subtract 1b: subtract 1 byte of all current image values. 
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Note: the Image Info option may be used at any time to control the output of 
the Preprocessing functions as well as to examine further required steps to 
setup a MSPA-compliant input image. 
 
 

1.2.2 Convolution 

The Convolution menu offers the choice for one of the following image 
convolution filters: 
 
 Median: Median filtering is effective in removing salt and pepper noise, 

(isolated high or low values).  The median is the middle value of a given 
data array, which should not be confused with the average value.  A set of 
predefined median filter box sizes is available in the submenu. 
 

 Boxcar: Similar to Median, this filter computes the average value instead. 
 

 Lee: The Lee filter technique (Lee, 1986) will smooth additive image noise 
by generating statistics in a local neighborhood and comparing them to the 
expected values.  A set of predefined box sizes to be used for the Lee filter 
is offered in the submenu. 
 

 Sigma: This filter computes the mean and standard deviation of pixels in a 
box centered at each pixel of the image, but excluding the center pixel.  If 
the center pixel value exceeds one standard deviation from the mean, it is 
replaced by the mean in the 5×5 box overlaying the pixel of investigation. 
 

 Wavelet: This option will open up a new interface for wavelet processing 
(Please note that this interface will only be available on systems having the 
separate IDL wavelet license). The left part of the interface (Figure 2) 
provides a graphical display of the original image, the filtered image, the 
wavelet coefficients, and the power spectrum. The right part allows for the 
selection of first, the wavelet family (Daubechies, Haar, Coiflet, Symlet) 
and their respective order and second, the cumulative power to use for 
denoising as well as hard or soft (= stronger smoothing) threshold. The 
results are displayed in the display Filtered image as well as in a text box 
at the bottom right. Finally the File → save/close option is used to apply 
this filter and to return to the main interface of the program. 
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Figure 2: The Wavelet interface providing a variety of wavelet and denoise options to be 
applied to the original image (top left) and resulting in the filtered image (top right). 

 Hilbert: The Hilbert function outputs a series that has all periodic terms 
phase-shifted by 90 degrees. This transform has the interesting property 
that the correlation between a series and its own Hilbert transform is 
mathematically zero. 
 

 User-Defined: A popup window allows the user to select or customize a 
kernel within dimensions within [3, 501] to be applied to the current image. 
 

 

Figure 3: The Define Kernel interface showing options to define the kernel dimension 
within the range [3, 501], select a square and/or a binary kernel and a reset option to go 
back to the default kernel for the current application. 

 

1.2.3 Equalization 

The Equalization menu offers the choice for one of the following image 
processing algorithms: 
 
 Contrast: The image contrast can be adjusted in an interactive mode. 

This option will close the main window and open up a new, dual window 
interface (Figure 4). The window on the left displays the histogram of the 
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brightness values of the image and two color bars, which can be dragged 
with the mouse to set a lower and upper limit for the intensity range into 
which the image will be rescaled. The result of this procedure is shown in 
the preview window on the right, which can be saved in a variety of image 
formats from the Controls → Save image as menu.  Furthermore, the 
maximum pixel density may be reset from the Controls → Max pixel 
density menu to adequately display the histogram. Finally, choosing 
Quit/Accept will close this interface, return to the main interface, and 
cancel/apply the selected settings to the current image. 

 

 

Figure 4: The Contrast interface showing on the left the histogram of the brightness 
values including the two color bars to define the contrast range; and on the right the 
preview of the selected contrast range applied to the current image.  

 
 Histogram Equalization: This function is used to obtain the density 

distribution of the input array. The histogram is integrated to obtain the 
cumulative density-probability function and a histogram-equalized image is 
returned. 
 

 Adaptive Histogram Equalization: This function applies contrast 
enhancement based on the local region surrounding each pixel. Each pixel 
is mapped to an intensity value, which is proportional to its rank within the 
surrounding neighborhood. 

 
 

1.2.4 Thresholding 

This option will open a dual window (Figure 5). The left window displays a 
histogram of the brightness values from the current image. A color bar 
indicating the current threshold value can be moved with the mouse to set a 
new threshold value, which is displayed in the right window of this interface. 
The Controls menu provides the option to save the current preview to an 
image in a variety of image formats and to redefine the maximum pixel density 
in order to best display the brightness value distribution of the histogram. 
Finally, the Quit or Accept buttons are used to cancel/apply the selected 
threshold. Please note that this process results in a binary image and can 
therefore only be applied once. 
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Figure 5:  The Thresholding interface provides a color bar to set and preview a 
brightness threshold value on the current image.         
 

 

1.2.5 Edge enhance 

This Edge enhance menu provides a series of edge enhance filters which are 
described in the following: 
 
 Canny: This filter produces results similar to the Sobel operator, but is 

separable (Canny, 1986).  This means that it can be performed in two 
passes, computing the derivative in the horizontal and the vertical 
direction.  They are then combined to calculate the gradient or the 
difference of the two components.   

 Laplace: The image is convolved with the kernel       
 

 
 Roberts: The diagram below shows the principle of the Roberts operator 

(1965) where two differences in orthogonal directions are combined to 
determine the gradient.  
 

      
 

 Sobel: Similar to the Roberts filter, the Sobel filter computes the 
derivatives in two orthogonal directions, which are combined as the square 



 12 

root of the sums of their squares to obtain a result independent of 
orientation. 
 

 Sharpen: This filter adds the Laplace filter of the image to the image itself. 
The Define Kernel window (Figure 3) offers the option to use a different 
user-defined filter. 
 

 Unsharp masking: This filter subtracts the original image from a 
smoothed version of the original image. Different smoothing box sizes are 
selectable from the submenu.  
 

 Skeleton: This filter combines thresholding with the Sobel filter.  
 
 

1.2.6 Morphological 

Mathematical morphology is a methodology of analyzing digital image objects 
on the basis of shape. A discussion of this topic is beyond the scope of this 
manual. A suggested reference is Soille, 2003; In short, a user-selectable 
object of predefined size and shape (structuring element) is defined and the 
image is scanned for the presence or absence of this shape of interest (some 
examples in Table 1). This option will open a new window (Figure 6) providing a 
series of morphological filters (Dilate, Erode, Open, Close, Tophat, Gradient), 
structuring element types (horizontal, vertical, diagonal up, diagonal down, 
circular) and sizes (1-10). Any combination of filter and structure type and size 
can be selected and tested by pressing the Test button in the upper panel. 
The Define kernel window (Figure 3) allows for selection of the default or user-
defined kernel to be applied to the previously selected settings. The result of 
this process is displayed in the graphical display of this window.  Other 
combinations may be tested at any time after restoring the original state in the 
display via the Reset button. When using the Tophat-filter, the contrast of the 
resulting image can be adjusted with the sliders in the horizontal panel above 
the display. Finally, the Quit/Accept button will close this window and 
cancel/apply the selected filter settings to the current image in the main 
window.  

 

Figure 6: The Morphological filter interface providing a preview for a variety of 
combinations of filters with structuring element type and sizes. 
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Filter Description 

Dilate fills holes of size equal to or smaller the structuring element. 

Erode removes islands smaller than the structuring element 

Open an erosion followed by a dilation, pixels are removed 

Close a dilation followed by an erosion, pixels are added 

Tophat = image – open(image) on an inverted image to show low 
brightness peaks 

Gradient = dilate(image) – erode(image) to highlight the boundary of 
the structure 

Table 1:  Description of some basic morphological filters. 
 

 

1.2.7 GIS Software 

The GIS Software menu provides access to the following GIS related software 
packages on the host PC running GuidosToolbox: 
 
a) Conefor: this menu provides access to the Conefor GUI and command-

line version, related documentation, and the Conefor homepage. The entry 
Check for Updates permits to test for and if available install a newer 
version of the Conefor GUI. 
 

b) JRC SW: this menu provides links to other software projects developed at 
the Joint Research Centre of the European Commission. Those projects 
may suite into the scope of GuidosToolbox, such as: 
IMPACT: this software toolbox offers a combination of elements of remote 
sensing, photo interpretation, and processing technologies in a portable 
and stand-alone GIS environment allowing users to easily accomplish all 
necessary pre-processing steps to produce a reliable land cover map from 
Earth observation data.  
Nestedness:  is a measure of order in an ecological system, referring to 
the order in which the number of species is related to area or other factors. 
The more a system is "nested" the more it is organized. 
 

c) GDAL Terminal: this option will open a separate terminal to access all 
GDAL-commands.  Use this terminal to work on your data, for example to 
reproject (gdalwarp), format conversion (gdal_translate), get information 
(gdalinfo), and much more. The GDAL-commands of the Linux and 
Windows versions are provided by the included FWTools package, and in 
the Mac version via the kyngchaos GDAL-framework.  
 

d) OpenEV Viewer: this option will open a separate window with the image 
viewer OpenEV as provided by the FWTools package.  Note that OpenEV 
is not available in the Mac version of GuidosToolbox.  

 
e) QGIS: this option will open QGIS if it is found in the operating system. 

 
 

http://www.conefor.org/
http://www.conefor.org/
http://forobs.jrc.ec.europa.eu/products/software/
http://ecosoft.alwaysdata.net/
http://www.gdal.org/gdal_utilities.html
http://fwtools.maptools.org/
http://www.kyngchaos.com/software/unixport
http://fwtools.maptools.org/
http://www.qgis.org/
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1.2.8 Original image 

Selecting the Original Image button can restore the initially loaded image.  
 

1.2.9 Undo/Redo 

GuidosToolbox stores the settings of one processing step. The Undo button 
may be used to undo the last processing step. If selected, this button will 
change to Redo allowing reverting to the previous step.  
 
 
 

1.3. The Image Analysis pull-down menu 

The Image Analysis pull-down menu offers the following options: 
 Pattern 

 Network 

 Fragmentation 

 Distance 

 Cost 

 Contortion 

 Change 

 

1.3.1 Pattern 

This menu provides access to the following pattern analysis tools: 
 
 MSPA: this option will process a binary input image using the 

mathematical morphology algorithm described in Soille & Vogt, 2009 with 

application details outlined in the MSPA Guide. 

 
 Moving Window: this menu provides access to several moving window 

algorithms. Via an initial pop-up window, the user can specify the size of a 
square (kernel) window, which is then applied to the current image. Here, 
this user-defined window is overlaid over each pixel of the input image, the 
selected metric is calculated for the area of the window, and the result is 
re-assigned to the center pixel of the overlaid window in the output image. 
All texture indices in this menu are derived from analyzing the attribute 
adjacency table (e.g., Musick and Grover 1991), in which Fij (i,j = 1 to t) is 
the frequency of adjacent pixel pairs with land-cover types {i,j}. When 
forming the attribute adjacency table, adjacency is evaluated in the four 
cardinal directions, each edge is counted once, the order of pixels in pairs 
is not preserved, and pairs involving a missing pixel are not included 
(Riitters et al. 1996b). The metrics P2 and LM are calculated from the 
proportions of cell values in the window. For those metrics, missing cell 
values are not included in the calculation, and the calculation result is 
missing if all cells in the window are missing.  The metrics P22 and P23 
are calculated from the cell|cell adjacency values (edge) proportions in the 

http://dx.doi.org/10.1016/j.patrec.2008.10.015
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window. We define N as the total number of edges between all pixels in 
cardinal directions, and the subset n as the number of edges that have 
foreground on one side or the other. All edges (N-n) that do not have 
foreground on either side are excluded in the metric calculation. If there 
are missing cells in the (kernel) window, the edges involving missing cells 
are not included. As a result, the total number of edges is less than N and 
the total number of edges involving foreground may be less than n, if 
missing cells are adjacent to foreground cells. Finally, the overall 
contagion measures Shannon and SumD account for all classes in the 
image (while P22 is based only on the foreground class). In this sense P22 
can be seen as class-level contagion (one row of the attribute adjacency 
table), while Shannon/SumD is landscape-level contagion (the entire 
attribute adjacency table). The following moving-window processing 
options are available:  
 
- LM (Landscape Mosaic): a tri-polar classification of a location according 
to the relative proportions of three classes in the window surrounding that 
location. The classification model uses the critical values of 10%, 60%, 
and 100% along each axis to partition the tri-polar space into 19 mosaic 
classes. More details on the concept of Landscape Mosaic and application 
examples can be found in Wickham et al. (1994) and Riitters et al. (2009).   
 
                                                                                          
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7: The Landscape Mosaic (LM) tri-polar classification scheme showing 19 
mosaic classes and their proportions of the 3 land cover categories Natural, 
Agriculture, and Developed. A capital letter denotes more than 60% and a small letter a 
contribution in the range of [10-60]% of a given land cover category. 

 

The input image for LM must be a Byte array with no more than 3 target 
classes with the assignment AND (1-Agriculture, 2-Natural, 3-Developed) plus 
an optional class for missing values (0 Byte). 
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- P2: the proportion of foreground pixels (2b) in the moving window. More 
details on the concept of P2 and P22 (below) and application examples can 
be found in Riitters et al. (1997, 2002).  

The input image for P2 must be MSPA-compliant: a Byte array having 0b – 
missing (optional), 1b – background, 2b – foreground. 

 
- P22: the proportion of adjacent pixel pairs in cardinal directions that include 
at least one foreground pixel, for which both pixels are foreground (2b|2b). 
Note: If n = 0, then P22 is missing. P22 estimates the conditional probability 
that, given a foreground pixel, its neighbor is also foreground.  

The input image for P22 must be MSPA-compliant: a Byte array having 0b – 
missing (optional), 1b – background, 2b – foreground. 
 
- P23: the proportion of adjacent pixel pairs in cardinal directions that include 
at least one foreground pixel (2b), for which the neighboring pixel is interesting 
background (2b|3b). Here, the original data background (1b) is subdivided into 
non-interesting background (1b) and interesting background (3b). A P23 map 
shows foreground (2b) fragmented by interesting background (3b). More 
details on the concept of P23 and application examples can be found in Wade 
et al. (2003) and Riitters et al. (2012). In a similar fashion one can divide the 
background not into two but into x subclasses. Then setup a loop, recode the 
input map accordingly with the interesting background subclass x set to 3b, 
and run P23 in a loop for each of these recoded maps in order to retrieve the 
impact of each background subclass x on the foreground class. For example, 
a land-cover map may contain the four classes Forest, Developed, 
Agriculture, and Water. If we choose Forest as foreground then we have: 
1=PFF+PFD+PFA+PFW. Here, PFF is the proportion of pixel pairs having Forest-
Forest (P22 in GuidosToolbox), and the other 3 components describe the 
proportions of Forest to Developed, Agriculture, and Water, resp. These 3 
components (P23 in GuidosToolbox) then describe how the foreground 
(Forest) is fragmented by each of the remaining background land-cover types.   
Note: if all background is interesting, then P23 = (1 – P22).  By taking 
different subsets of background as interesting, it is possible to partition the 
total fragmentation (1 – P22) into components attributable to different 
background classes. 
The input image for P23 must be a Byte array having the classes: 
- Missing, 0b (optional), 
- non-interesting background, 1b (optional),  
- foreground, 2b (mandatory), 
- interesting background, 3b (mandatory).  
 
- Shannon: Shannon edge-type evenness, the classical overall contagion 
measure used in Landscape Ecology literature, see Li and Reynolds, (1993).  
The input image must be a Byte array with optional missing pixels set to 0 
byte.  

 
- SumD: an alternative contagion measure is the sum of the main diagonal 
(“same-class”) elements of the attribute adjacency matrix, see Wickham and 
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Riitters (1995) and Riitters et al. (1996). In contrast to the Shannon index this 
index is not affected by adjacencies among different classes, and the same 
value is obtained for all of the ways pixel pairs could be tallied.  
The input image must be a Byte array with optional missing pixels set to 0 
byte.  
 
 
 

1.3.2 Network 

The MSPA-analysis can be converted into a Network for further analysis in a 
graph-theory application, here Conefor (Saura, 2009a). A Network is 
composed of Nodes (↔ MSPA class: Core) and Links (MSPA class: Bridge = 
connectors between different Cores) and the remaining MSPA classes are 
neglected. A connected set of nodes and links is called a Component. The 
following Network options are available after a MSPA-analysis: 
  
 NW Components: individual components of the network are displayed in 

alternating colors. The color black is used for node-only components 
having no links.  The information window below the main display shows 
the unique component identifier, the total area of the component, and the 
contribution of links. Saving the result will produce the following three files:  
a) <name>_nw.tif: same graphics as displayed in GuidosToolbox 
b) <name>_nw_nwdata.tif: image with component IDs                        
c) <name>_nw_stat.txt (only when saving the entire image): statistics for 
each component, total area, and contributed area of links. 
 

 Node/Link Importance: this option will show the connectivity importance 
for each node and each link of the network. The connectivity importance is 
calculated according to equation 4 in Saura (2009b) and having the 

following three contributions:𝑑𝑃𝐶 = 𝑑𝑃𝐶𝑖𝑛𝑡𝑟𝑎 + 𝑑𝑃𝐶𝑓𝑙𝑢𝑥 + 𝑑𝑃𝐶𝑐𝑜𝑛𝑛𝑒𝑐𝑡𝑜𝑟, 
where the importance corresponds to the term dPCconnector only. The 
information window below the main display shows the node/link ID, and its 
absolute and relative connectivity importance. The top 1, 5, 10 % relative 
importance of nodes/links are displayed in decreasing intensity of green 
and red color.  
Saving the result will produce the following four files:  
a) <name>_cs22.tif: same graphics as displayed in GuidosToolbox 
b) <name>_cs22_conn.tif: the connectivity importance for each node and 
link. 
c) <name>_cs22_ids.tif: the unique identifier of each node and link where 
nodes have a negative sign to distinguish them from links. 
d) <name>_cs22_stat.txt (only when saving the entire image): statistics for 
each component, its nodes and links, area, and connectivity importance. 
 

 NW Component Connectors: this option will locate and calculate the 
connectivity importance of the 10 shortest pathways (links) between the 5 
largest components. The connectivity importance will account for 
intermediate components if they are part of this pathway. The information 
window below the main display shows the area and ID of the components 

http://www.conefor.org/
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and the connectivity importance of each component connector. Please 
note that the new links will show properly in zoom mode but they may not 
show properly in the overview display because this image is only a 
resampled version of the entire full-resolution image. Saving the result will 
produce the following two files:  
a) <name>_nwconnect.tif: same graphics as in GuidosToolbox. 
b) <name>_nwconnect_stat.txt (only when saving the entire image): 
statistics for the 10 links connecting the 5 largest components, starting 
from the largest to the second largest (12), to the third (13), fourth (14), 
and fifth largest (15), the second largest to the third largest (23), etc. Each 
line shows the IDs of the individual components connected (A and B); the 
connectivity importance of this new link accounting for intermediate 
components along the pathway; the entire length of the link and the 
effective length of it through the background; the component IDs of 
intermediate components if they were encountered along the pathway of 
this link. Here, the effective length can be seen as a proxy for the costs to 
establish such a pathway. 
Note: A note of caution on images having a very large single component 
or with a Foreground cover > 50 %. Here, the connecting pathway 
between smaller component pairs may traverse a very large component. 
When deriving the importance, this pathway is removed, which will result in 
segregating the network and thus may lead to counterintuitive results. 
 

 MSPA Conefor Inputs: this option will setup and save the two input files 
nodes_mspa_<input>.txt and links_mspa_<input>.txt for further analysis in 
Conefor (Saura, 2009a). Use this option for detailed graph-theory analysis, 
which is beyond the network connectivity importance provided within 
GuidosToolbox. Note: when using the option MSPA Conefor Inputs the 
connectivity is defined via the MSPA-detected structural connectors 
(bridges). This is different to the option Conefor Inputs, where the 
connectivity is defined via the pairwise distance of image objects. 

 
 

1.3.3 Fragmentation 

Fragmentation can be seen as the spatial heterogeneity, or the spatial 
composition and arrangement of foreground objects in an image. It accounts 
for the number of objects and the distance between them, hence addressing 
foreground and background characteristics at the same time. Due to its 
holistic nature the description of fragmentation is rather complex and, in the 
case of landscapes, usually defined for a given species of interest and as 
such very specific. Moreover, current fragmentation definitions are only 
descriptive and for this reason do not allow quantifying the degree or changes 
of fragmentation for a given image. For quantifying fragmentation, we apply 
different concepts. All provide normalized values in the range [0% – 100%]. 
The Entropy requires a minimum image dimension of 500 pixels in any 
direction. In the Divide Range panel below the viewport the fragmentation 
values can be grouped into small/medium/large. The title bar in 
GuidosToolbox shows fragmentation values for the entire image, the 
foreground only, and the range of minimum-maximum values.  

http://www.conefor.org/
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The aim is to describe fragmentation using different concepts. Based on the 
nature of the selected approach each concept will provide slightly different 
results, which may be more or less suitable for a given task. Besides 
quantifying the fragmentation state on a given map these measures permit the 
comparison of the degree of fragmentation of different sites, the quantification 
of changes in fragmentation over time, and monitoring as well as measuring 
progress in planning programs and political directives. 
 
The Fragmentation submenu Index provides methodologies resulting in a 
normalized fragmentation value (index) for the entire image. 
 
 Entropy: this option will calculate the Entropy of the entire image.  
 
 Hypsometry: starting from the Euclidean distance map a first pop-up 

window shows the Hypsometric Curve (Figure 8).  
 

 
Figure 8: Hypsometric Curve for the Euclidean distance distribution in the 
foreground and in the background and related distance measures. 
 
The Hypsometric Curve is a summary description of the Euclidean 
distance histogram. When viewing the image distance distribution as a 
pseud-elevation map the Hypsometric Curve summarizes the relief or 
contour lines in the foreground the same process is known as bathymetry 
in the background. Figure 8 shows the normalized cumulative frequencies 
of Euclidean distances as well as the following related statistics for the 
background and the foreground: 
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- Hypsometric Index (HI): adb/bg_max   or   adf/fg_max 

- Hypsometric Area (HA): integral area under the curve 

- Average distance (adb/adf) 

- Maximum distance (bg_max/fg_max) 

- Number of objects (bg_obj/fg_obj) 

- Total area of objects (bg_area/fg_area) 

- Representative area (bg_Arep/fg_Arep)  

The Representative Area is calculated for a vicarious object of circular 
shape with a radius of adf/adb. In a similar way, a representative square 
object could be defined having the edge length sqrt(Arep). As with the 
Average Distance (adf/adb), changes in the Representative Area are 
indicative for fragmentation processes. 
 
 
A second pop-up window shows the Normalized Hypsometric Curve. 
 

 
Figure 9: Normalized Hypsometric Curve for minimum (black), maximum 
(red), and actual fragmentation state in the foreground (green) and in the 
background (blue). 

 
The Normalized Hypsometric Curve (NHMC) is the Hypsometric Curve 
scaled by the maximum distance in the foreground and in the background. 
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Figure 9 shows the NHMC for three images having the same dimension as 
the actual image and the following three conditions: 
- minimum fragmentation (black): NHMC of an image with maximum 
foreground aggregation: all foreground pixels accumulated to a circle in the 
center of the image. If the foreground coverage is too large to fit a circle in 
the image a rectangle is used instead.   
- actual image (blue/green): NHMC of the actual image 
- maximum fragmentation (red): NHMC of a checkerboard image with 50% 
coverage. This theoretical maximum condition for fragmentation is 
characterized by all foreground as well as all background pixels having a 
distance of 1 and thus resulting in the step-function outlined in red in 
Figure 9. 

 
For a given image, the degree of fragmentation corresponds to the area 
covered between minimum fragmentation (black) and maximum 
fragmentation (red). In Figure 9 this area is highlighted in blue for the 
background and in green for the foreground. Accounting for the dual 
nature of fragmentation (foreground is fragmented by background and vice 
versa) the degree of fragmentation for a given image is defined by the 
weighted sum of fragmentation in the foreground and the background:  
 
     Frag(hypso) = (bg_area/100.0 * bg_frag) + (fg_area/100.0 * fg_frag) 
 
The so-defined fragmentation provides values in the range of [0, 100] %, 
accounting for and summarizing key fragmentation aspects: duality, 
perforations, amount, division, and dispersion of image objects.   

 
 
 
 MeshSize: introduced by Jaeger (2000) the effective mesh size (meff) is 

based on the probability of two points chosen randomly in a region will be 
connected. The probability is converted into the size of a patch (meff) by 
multiplying it by the data area of the image: 

                        
with n = number of patches, Atotal = data area, Ai = area of patch i (i=1,..,n). 
Mathematically, the MeshSize is very similar to the Area-weighted Mean 
Patch Size, the only difference is the division by the data area instead of 
the foreground area. Hence, the Area-weighted Mean Patch Size provides 
an absolute measure of patch structure, whereas the MeshSize provides a 
relative measure of patch structure. The unit of MeshSize is area, i.e. 
hectare, and it corresponds to the size of meshes of a regular grid having 
the same degree of fragmentation as the actual image. MeshSize is mainly 
an indication of foreground segmentation but by definition cannot account 
for other fragmentation aspects like perforation and dispersion. The range 
of MeshSize is from a theoretical minimum value of zero (totally 
fragmented to have virtually no more foreground area; relative 
fragmentation = 100%) to a maximum value of Atotal, when the entire data 
area is covered by foreground (relative fragmentation = 0%). The smaller 
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the MeshSize the more fragmented is the landscape. Within 
GuidosToolbox the relative fragmentation described by MeshSize is 
obtained by scaling the MeshSize of the actual image into the range of 
minimum/maximum MeshSize.  
Note: the calculated MeshSize in hectare is calculated assuming a pixel 
resolution of 1 meter. MeshSize for data with different pixel resolution can 
be derived by multiplying the MeshSize from GuidosToolbox with the 
square of the actual pixel resolution. For example: if the MeshSize (within 
GuidosToolbox and assuming 1 meter pixel resolution) was calculated as 
10 ha; and the actual pixel resolution of the data is 30 meter, then the 
actual MeshSize of the data is 10 ha * 302 = 9000 ha.    

 
 

The Fragmentation submenu Map provides methodologies resulting in spatial 
distribution of normalized fragmentation values.  
 
 Entropy: In thermodynamics, entropy describes the degree of disorder in 

a system. Transferring this concept into spatial geometry (raster images) 
we can use entropy as a descriptor for spatial fragmentation. Starting from 
the classical definition of entropy in information theory H = -∑ Pi * log(Pi) 
(Shannon, 1948) we define the discrete set of probabilities Pi as the 
probability that the difference between 2 adjacent pixels is equal to i and 
log is the base 2 logarithm. The original entropy definition has been 
implemented in many ways and it is important to distinguish the above 
definition of Pi from other commonly used indicators such as Shannon’s 
diversity index or the Eveness index (where Pi is the proportion of species) 
and variations of contagion indices (where Pi is the proportion of different 
type of pixel edges). In short, in Shannon’s original concept Pi refers to 
percentages of species classes in categorical maps, as defined in the 
species diversity literature. In contrast, here we investigate differences 
between cell values in all 8 directions (that is, the values of i), which is 
meaningful because raster images are continuous variables where their 
magnitude has meaning. While the entropy in the  edge-type evenness is 
derived from the attribute adjacency table, the spatial entropy here is 
calculated on spatial tiles and assuming 8-connectivity for the foreground 
pixels.  
For a given amount of foreground area, an image with a single compact 
foreground object has minimum entropy while the entropy reaches its 
maximum value when the given area is split into the maximum number and 
dispersed over the entire image. Maximum entropy is thus found for a 
checkerboard distribution. These two boundary conditions define the 
possible range of fragmentation in the image. The spatial entropy is 
calculated by averaging calculations using box size tiles of 50 and 33 
starting from the center of the image. This approach replaces the precise 
but slower performing moving window computation. Finally, a smoothing 
filter is applied in order to return a spatial contiguous per pixel distribution. 
The result shows the normalized fragmentation as a function of spatial 
entropy.  

 

http://en.wikipedia.org/wiki/Diversity_index
http://en.wikipedia.org/wiki/Diversity_index
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 Entropy_mw: same as Entropy but using a moving window approach with 
a box size of 50x50 pixels. 

 
 
 Contagion: Contagion describes the degree of clumpiness of image 

objects. With this definition, fragmentation can be defined as the 
complement of contagion (1 – contagion), an image region with high 
contagion is equivalent to having low fragmentation. The contagion of 
foreground objects is calculated via the moving window metric P22 in the 
user-selected box size window. The result shows the normalized 
fragmentation as a function of spatial contagion.  

 
Note: Entropy and Contagion can both be seen as local aggregation 
measures but with an important difference: while Contagion will consider the 
Foreground objects only, the Entropy based fragmentation assessment is 
based on the simultaneous evaluation of Foreground and Background 
together (duality). For example, an image with predominant Background cover 
(i.e. 95 %) and a few isolated Foreground objects (5 %) will result in high 
fragmentation values for Contagion. For Entropy, this image will have low 
fragmentation values because the dominant area coverage (Background) is 
only slightly fragmented by the Foreground. In fact, we will get the same low 
fragmentation value for Entropy when using the inverted image with 95 % 
Foreground cover and 5 % background; in this case the dominant area 
coverage is now Foreground, which is only slightly fragmented by the 
Background. In short, Entropy derives Fragmentation for the interplay of Fore- 
and Background while Contagion will focus on the Foreground only. 
 

1.3.4 Distance 

This menu provides several options for distance analysis.  
Note: when using geotiff data the distance value in pixels is only meaningful 
for images having equal-area projection!   
 
 Label Objects: this option will label all foreground objects having a size 

larger or equal the value specified via the MSPA parameter 2 EdgeWidth. 
In addition, the MSPA parameter 1 FGconn can be set to define 4 or 8-
connectivity for the foreground objects. Labeled objects are displayed in 
alternating colors, objects smaller than the minimum object size in pale 
blue, and potential missing data is displayed in white. Moving the mouse 
cursor over a labeled object will show the object ID and the number of 
pixels of the selected object.  Saving a label object image will produce the 
following four files with the prefix <name>_labelobjects_<X>conn_<Y>, 
where X stands for 4- or 8-connectivity and Y stands for the selected 
minimum object size in pixels:   
a) prefix.tif: same graphics as displayed in GuidosToolbox 
b) prefix_ids.tif: the unique identifiers of the objects 
c) prefix_pixels.tif: the number of pixels for each object 
d) prefix_stat.txt (only when saving the entire image): table listing the 
number of pixels for each object. 
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 Euclidean Distance: this option calculates the approximate Euclidean 
distance map for both, the background and the foreground. A pop-up 
window shows the distance histogram including foreground and 
background specific information on the average distance value (adf/adb), 
the total number of objects (fgo/bgo), and the maximum distance found in 
the image. Background data have a negative sign to distinguish them from 
foreground data. The GuidosToolbox title bar shows adf/adb and the 
spatial distance distribution is displayed in the viewport. For each pixel, 
this map shows the shortest distance to the nearest foreground/ 
background boundary. The distance is provided in pixel units since the 
actual spatial pixel resolution is unknown. The color code is designed to 
mimic a pseudo elevation map: blue colors represent ocean (background), 
yellow/red/green colors represent land or mountains (foreground), and a 
value of zero is assigned to the coastline (intersection of 
foreground/background). Saving a Euclidean distance image will save the 
actual distance image as well as the statistics shown in the histogram 
display. As in any other image, the zoom function can be used to retrieve 
more detailed pixel information via the mouse cursor.  
 

 Influence Zones: an influence zone is defined as the outside region 
separating selected foreground objects. The boundary of an influence 
zone is derived by applying a morphological watershed operator to the 
Euclidean distance map of the background area in the image. Considering 
the gray scale (Euclidean distance) image as a surface, each local 
minimum can then be thought of as the point to which water falling on the 
surrounding region drains. The boundaries of the watersheds lie on the 
tops of the ridges. Small objects in the original image can produce 
spurious minima in the gradients, which leads to over-segmentation. For 
this reason the default minimum object size is set to 500 pixels. Omitted 
Objects smaller than the minimum object size are displayed in pale blue 
color. Objects for which influence zones are calculated are displayed in 
alternating colors. Potential missing data is displayed in white and the 
influence zones boundaries (watershed lines) in black color. Influence 
zones are calculated for foreground objects larger or equal to the specified 
minimum area in pixels, which can be set via the MSPA parameter 2 
EdgeWidth.  
In addition, the panel below the viewport allows setting buffer zones for 
both, foreground and background. Here, a non-zero value for the 
foreground buffer zone corresponds to the perimeter width of the 
foreground objects to be excluded from the calculation. Consequently, this 
parameter can be used to define core-foreground objects. In this case the 
title-bar will show, and the calculation will be conducted for foreground 
core objects having the minimum area specified via the MSPA parameter 2 
EdgeWidth. A non-zero value for the background buffer zone will add a 
dark grey colored buffer zone of the specified width around, and if 
sufficiently large holes are present, inside the selected core or foreground 
objects. The boundary of the background buffer zone is depicted in pink 
color. Background buffer zones will terminate at the boundary of the 
influence zones. Clicking the Divide switch will reset both, the foreground 
and background settings to their default value of zero, omitting buffer 
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zones and showing influence zones only. In summary, the influence zones 
provide a segmentation of the user-specified objects and buffer zones can 
be added to define core areas as well as outreach zones of any size. 
 
Note: the threshold of small objects to be excluded from the calculation 
can be set to any value via the MSPA parameter 2 EdgeWidth drop-down 
menu. You can either select a pre-defined value or specify a custom value 
in the first entry of the drop-down menu. A new custom value will only be 
assigned after the Enter key has been pressed.  Having entered a new 
small object threshold value the influence zones will be recalculated 
automatically. A value of one (1) will calculate influence zones for all 
foreground objects. Since influence zones are defined to describe the 
outer region of objects they are calculated for filled foreground objects. 
For this reason, objects insides holes of surrounding objects will have the 
same object ID and hence, the total number of objects when calculating 
influence zones may be smaller compared to the total number for object 
labeling. Finally, as with Euclidean distance, the distance value in pixels in 
geotiff data is only meaningful for images having equal area projection!   
Saving an influence zone image will produce the following two files with 
the prefix <name>_influence_<X>conn_<Y>_<b1>_<b2>, where X stands 
for 4- or 8-connectivity, Y stands for the selected minimum object size in 
pixels, and b1 and b2 stand for the selected foreground and background 
buffer zone width, respectively:   
a) prefix.tif: same graphics as displayed in GuidosToolbox 
b) prefix_ids.tif: image showing the unique identifiers of the objects,  buffer 
zones and watersheds, etc. using negative values for special data and 
positive values for the individual objects, i.e. the following notation: 
 
- 6: buffer zone 
- 5: buffer zone boundary 
- 4: missing data 
- 3: watershed 
- 2: omitted Foreground pixel 
- 1: hole in Foreground 
  0: Background 
1-x: unique object identifier 

 
 

1.3.5 Cost 

The modules in this section are designed to conduct a Cost analysis, requiring 
the following two input images:  
 
a) Resistance map: a single-band image of datatype Byte providing a 

relative resistance value within [1, 100] byte for each pixel. Resistance 
values of 0 are not allowed. If the resistance map contains values larger 
than 100 byte then the user should setup an appropriate re-scaled 
resistance map within [1, 100] byte, for example using the Recode option. 
A resistance map could be a land-cover map, where for a given species a 
specific resistance value is assigned to each land-cover class. The land-
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cover class specific resistance value can then be seen as a measure of 
the difficulty for that species to traverse a pixel within that land-cover class.   
  

b) Marker map: a single-band image of datatype Byte with the same 
dimensions as the resistance map and having the following values: 
0b: background  
1b: start object A (either a single pixel or the area of an object) 
2b: target object B (optional, only needed for Cost Map AB) 
3b: no or missing data, or areas that should be neglected (optional) 
The start/target objects A and B must be unique and must not overlap. 

 
These two input maps are combined and the cost map is calculated with a 
generalized geodesic distance function (Soille 1994). The Cost Marker map 
can be setup via the dedicated user interface: Cost Marker Image. 
 
The Cost submenu provides the following two options: 

 
 Cost Map A: this option will calculate and display the cost map starting 

from object A.  
 

 Cost Map AB: this option will calculate a cost map starting from object A 
and a second one starting from object B, which are then combined into the 
final cost map AB. Pixels having the minimum value of this map are 
defined as Least Cost Range pixels and the skeleton of this range is called 
the Least Cost Path. The latter is a subset of the Least Cost Range and 
shows one trajectory of minimum cost between the start and target objects 
A and B.  

 
The title bar will inform about the minimum and maximum cost values 
encountered in the image. The cost inside a start/target object is set to zero. 
The division panel below the viewport can be used to group the cost surface 
into the ranges small/medium/large using either pre-defined or custom values 
in the respective threshold drop-down menu. This option may be of interest to 
highlight cost corridors between A and B with a slightly increased minimum 
cost (i.e. 1.1 x least cost) in order to visualize and/or investigate potential 
alternative connecting pathways. While positive values show the actual cost 
the following values are reserved for special assignments: 
 
- 3: pixels that cannot be reached from or are between the start/target object 
- 2: missing data 
- 1: start/target object A/B 
  0: Least Cost Path 
 
Depending on the selected file format saving a cost map will provide: 
- GeoTiff: <input filename>_costmap<A or AB>-data/range_geo.tif, a twin set 
   of Geotiff-images of data type: 

a) long integer with the actual cost map  
b) byte matching the visual display of the GuidosToolbox viewport. When 

linked against the corresponding data image in a GIS this image may be 
useful to visualize the (user-selected) cost ranges.  
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- Generic-Tiff: <input filename>_costmap<A or AB>.tif, two images: 
a) long integer Tiff-image with the actual cost map  
b) byte PNG-image matching the visual display of the viewport.  

- Generic-PNG: <input filename>_costmap<A or AB>.png:  
   long integer with the actual cost values. 
 
The image files are accompanied by <input filename>_costmap<A or AB>.txt, 
providing a summary of the cost map options, minimum/maximum cost and, if 
selected, the cost range grouping thresholds. 
 

1.3.6 Contortion 

Contortion describes the degree of regularity of a foreground object perimeter. 
Its value corresponds to the number of times a given object perimeter 
direction changes its sign. Contortion can be used for shape description, in 
particular to distinguish random shapes from regular shapes. For example, 
when following the perimeter of a rectangle the direction changes one time in 
the horizontal and one time in the vertical direction → the contortion of a 
rectangle is 2. In satellite images, regularly shaped objects such as buildings, 
and agricultural fields will have low contortion values while natural objects are 
more likely to be non-regular and hence have higher contortion values. An 
important feature of contortion is the rotational invariance: imagine two 
rectangular football fields, one in horizontal orientation and the other rotated 
by 45°. When represented in a raster grid the perimeter of the first field will 
have 4 corners, while the perimeter of the second field will have many more 
than 4 corners due to its staircase representation along the diagonal lines in 
the image grid. While the number of corners of these two football fields in the 
raster image representation is different, the contortion of them is the same, 
namely 2. The Contortion submenu provides the following three options: 

 
 Contortion: by default, the contortion is calculated for foreground objects 

having an area of larger or equal to 200 pixels. This setting avoids the 
time-consuming calculation for all small objects that may not be of interest. 
In the resulting image, small objects are denoted as omitted and displayed 
in black color. The title bar shows the fraction of calculated versus total 
number of foreground objects in the image. The Divide Range panel below 
the GuidosToolbox viewport can be used to group the contortion value 
range into small/medium/large using either pre-defined or custom values in 
the respective threshold drop-down menu.  
Note: the threshold of small objects to be excluded from the contortion 
calculation can be set to any value via the MSPA parameter 2 EdgeWidth 
drop-down menu. You can either select a pre-defined value or specify a 
custom value in the first entry of the drop-down menu. A new custom value 
will only be assigned after the Enter key has been pressed. Next, the 
contortion will be recalculated automatically. 
 

 Contortion/Pixels: this option will display the ratio of contortion by area 
for each calculated foreground object. While the small object threshold can 
be changed the Divide Range panel is not active for this option. 
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  Contortion/Perimeter: this option will display the ratio of contortion by 
perimeter for each calculated foreground object. While the small object 
threshold can be changed the Divide Range panel is not active for this 
option. 

 

1.3.7 Change 

This menu provides the following two options for change analysis. A popup 
window is used to specify two input images, which can then be processed for: 
 
 Simple Change: this option will calculate a simple by-pixel difference of 

image A minus image B, starting at the top left corner of the image. The 
dimension of the resulting image is equivalent to the smaller image of the 
two input images.  

 
 Morphological Change: this option will conduct a Morphological Change 

Detection (MCD), described in Seebach et al. (2013). MCD will remove 
unwanted spurious changes caused by mis-registration between classified 
maps and their thematic accuracies. MCD requires that both input images 
are binary MSPA-compliant maps (2b – FG, 1b – BG, 0b – Missing 
(optional)) in GeoTiff format, having the same projection, pixel-resolution, 
location, and an area in common. The resulting GeoTiff image will show 
the essential changes in the common area of input image A and B. The 
output values have the following assignment: 11b – BG/BG, 12b – BG/FG 
(gain), 21b – FG/BG (loss), 22b – FG/FG, 176b – neglected, spurious 
changes, 255b – undetermined (missing data in either input image). The 
title bar lists net percent change values for FG (Foreground) and FGi 
(Foreground interior area: 1-pixel eroded FG), with negative values 
indicating a net loss. Finally, Elasticity (Riitters et al., 2015) is the ratio of 
FGi to FG. For example, in case of forest loss higher elasticity values 
indicate higher fragmenting effects on the remaining forests.   
 

 Compare PNGs: this option will open two images into a new window. A 
slider at the bottom of the window can be used to change the transparency 
in order to directly compare pixels of the two images. 

 
 

1.4. The Help pull-down menu  

The Help pull-down menu offers the following options: 
 
 GuidosToolbox Manual 

 MSPA Guide 

 News 

 Homepage 

 Disclaimer 

 Changelog 

 GuidosToolbox Workshop 
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 Check for Updates 

 About GuidosToolbox 

 

1.4.1 GuidosToolbox Manual 

This option opens the GuidosToolbox Manual in a separate window. The 
manual provides general information on the organization of the graphical 
elements within GuidosToolbox and the nature and functionality of the various 
menus and options. 
 

1.4.2 MSPA Guide 

This option opens the MSPA Guide in a separate window. The guide contains 
important, detailed information on the input data requirements for the 
processing of MSPA, the MSPA parameters, the resulting MSPA image 
output, and on the use of the MSPA-standalone version. Please read this 
document carefully. It contains all MSPA related information, GuidosToolbox 
is only a graphical interface, designed to facilitate the MSPA processing.  

1.4.3 News 

This option displays current ongoing activities and upcoming changes to be 
included in a future version of GuidosToolbox. 
 

1.4.4 Homepage 

This option opens the GuidosToolbox homepage in a web browser providing 
current information on the GuidosToolbox software collection. 
 

1.4.5 Disclaimer 

This option opens the GuidosToolbox disclaimer in a popup window. 

  

1.4.6 Changelog 

This option displays recent changes and feature additions for the current 
version of GuidosToolbox. 
 

1.4.7 GuidosToolbox Workshop 

Use this option to install or upgrade the GuidosToolbox Workshop material. 
This material contains presentations with many details on the motivation, 
design, functioning, and application fields of the different methodologies 
available in GuidosToolbox. It is complemented by key reference publications, 
as well as sample data sets and instructions to illustrate using these tools. 
This package is used during the 1-2 day GuidosToolbox training courses but it 
should also be easy to follow by the interested user of GuidosToolbox.  
 

http://forest.jrc.ec.europa.eu/download/software/guidos/workshops/


 30 

1.4.8 Check for Updates 

Use this option to check for and install a Program and/or a new Revision 
release of GuidosToolbox. A Program release includes major changes within 
the libraries of the programing framework and thus requires a fresh installation 
of GuidosToolbox. A Revision release is a small patch, which will either fix 
issues found after the release of the current program version and/or add some 
new features. It can be installed automatically into an existing installation. 
 

1.4.9 About GuidosToolbox 

This option provides information on the currently installed version of 
GuidosToolbox, homepage and contact information, the operating system 
dependent accessible additional software, and the maximum image 
dimensions supported in GuidosToolbox. On Linux and Mac OS X the 
maximum supported image dimension for MSPA is recalculated dynamically 
accounting for the currently available amount of RAM in the system. 
 
 
 

2. The Image/Display Attributes window (top left 
panel) 

This panel allows changing the image and display attributes of the image 
shown in the viewport in the right panel.   

The left side provides: 
- Flip Vertical: select this option to vertically flip the image.  
Note: this option is not applicable for geotiff images. 
 

- Normalized: display the image values using either their apparent values 
(default) or normalizing them into the range [0, 100].  
 

- Autostretch: this switch will scale the present image values into [min, max].  
This feature can be used to visualize images with small contrast range when 
using color tables spanning the entire range of [0, 255] byte.  

 
The right side provides: 
- Select Colortable: a series of predefined color tables as well as a user-
defined one, which may be adjusted in a new window. 
 
- Zoom Mode/Factor: these settings are used to specify a rectangular Region 
Of Interest (ROI), a sub region of the image:  
Prior to the definition of the ROI, a zoom factor in the range of [1, 10] should 
be selected from the Factor drop-down menu. Next, a rectangular ROI is 
defined by holding down the left mouse button and dragging the mouse inside 
the graphic display. The selected region is outlined in green color and 
constantly updated until the mouse button is released. The selected zoom 
factor is then applied to the selected area and displayed in the viewport.  The 
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Zoom Mode button changes to Quit Zoom, providing the option to return to the 
display showing the entire image extent. 
 
- Image Info: a separate window will display details of the currently loaded 
image, such as data type, number of bands, unique pixel values, and 
geoheader information including projection name and EPSG-code if a GeoTiff 
image was loaded. 
 
 
 

3. The MSPA window (bottom left panel) 
This window is divided into the following two segments: 
 
 

3.1. MSPA Parameters 

This window allows changing the settings of the four MSPA parameters (more 
details can be found in Help → MSPA Guide): 
 
1. FGconn: The default setting for the connectivity of the foreground pixels is 

8-connectivity (cardinal and diagonal directions) but may also be 
constrained to 4-connectivity (cardinal directions only). 
     

2. EdgeWidth: The MSPA analysis scale driving the distance of the non-
Core boundary classes (default: 1); the selected value is equivalent to the 
resulting boundary width in pixels. The x-entry in the drop-down menu can 
be used to insert a custom value within [0, 100]. A new custom value will 
only be assigned after the Enter key has been pressed.  
 

3. Transition: Transition pixels are those pixels of an Edge or a Perforation 
where the Core area intersects with a Loop or a Bridge. The default value 
(1: tick mark set) is to show transition pixels as Loop or Bridge pixels 
connecting to the Core area. However, doing so will interrupt the visual 
integrity of a closed Edge or Perforation perimeter. The closed perimeter 
display can be maintained by switching transition to off (0: tick mark 
unset). Please note that when transition is off, short Bridges of 2 pixels will 
not be visible since they are hidden under the Edge/Perforation pixels.  
Note: Changing the Transition setting will only change the visual 
appearance but not the actual pixel values of the processed image. 
 

4. Intext: This parameter allows distinguishing internal from external 
background, where internal background is defined as completely 
surrounded by Perforation. The default is to enable this distinction, which 
will add a second layer of classes to the seven basic classes.  All classes, 
with the exception of Perforation, which by default is always internal (105 
byte), can then appear in internal or external background.   
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3.2. MSPA Statistics 

This option allows calculating simple statistics of the MSPA classes. The 
visualized colors of the seven basic MSPA classes are the basis for these 
statistics showing for each class the percentage (number of class pixels per 
foreground and per data area) and its frequency (number of unique objects of 
the given class). Please note that the purpose of these basic statistics is to 
provide a quick summary only and more elaborate analysis is left to the user. 
For example, the statistics do not account for the distinction of 
internal/external classes. Yet, since they are based on the visualized MSPA 
color classes, they will change when changing the parameter Transition, 
although this change has no effect on the image data itself. The statistics will 
be reset in case of changing a MSPA parameter impacting the statistics. More 
details on the MSPA classes is available in Help → MSPA Guide.  
 
 

4. The Viewport window (top right panel) 
This window displays the original, processed or the zoomed area of the 
image. The image is either displayed in its original size or automatically down-
sized to fit the viewport of GuidosToolbox. Any processing is performed on the 
original non-zoomed image.  
 
 

5. The Pixel Locator/Value panel 
This panel below the viewport shows the pixel coordinates, value and type for 
the current location of the mouse pointer in the viewport. This feature works in 
full display as well as in Zoom Mode and in addition will list the related specific 
class names when investigating certain image types in the viewport. 
 
 

6. The Divide Range panel 
This panel below the Pixel Locator/Value panel allows dividing the data range 
of the following image types into the 3 groups: small/medium/large. The two 
thresholds defining these groups are defined via two drop-down menus. The 
user can either select predefined settings or enter custom thresholds to define 
threshold values for the 3 groups. A new custom value will only be assigned 
after the Enter key has been pressed. 
- MSPA: divide the MSPA core area [pixels], 
- Fragmentation: divide the Fragmentation range [%], 
- Contortion: divide the Contortion range, 
- Cost: divide the Cost range, 
- Distance: divide the distance range [pixels] for foreground and background. 
- Influence Zones: define the width of buffer zones for Foreground (to define 
Core-objects) and Background (buffer zones ranging outside of Foreground or 
Core objects). 
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7. Limitations and known issues  
The following list summarizes certain limitations and suggestions for potential 
issues arising when using GuidosToolbox: 

 Maximum image dimensions: The supported maximum dimensions in x 
and y are listed under Help → About GuidosToolbox. On Linux and Mac 
OS X the maximum size for MSPA image processing is recalculated 
dynamically accounting for the currently available amount of RAM in the 
system. To increase the dimensions the user should exit from any other 
running applications occupying the system memory load.  

 Cost Analysis: at present this type of analysis is implemented using the 
data type long integer. For very large images, and depending on the 
average resistance values, the maximum of this data type may be 
superseded. In this case it will not be feasible to conduct a cost analysis.  

 GuidosToolbox window size: The size of the program window is driven 
by the currently loaded image dimensions and, at present, cannot be 
maximized to fit the entire screen.  

 Save Image → kml does not work: On certain 64-bit versions of MS-
Windows the option to save an image in kml-format may not work due to a 
conflict with other GIS-software installed in the system. A patch to address 
this issue is available in the folder C:\GuidosToolbox\guidos_progs\. If 
needed, the user should double-click the file fix_saveaskml.bat and 
provide the administrator password to apply the patch.  

 GDAL: The provision of OpenEV requires providing the rather old version 
1.6 of the GDAL (and related Proj) geospatial libraries. Current versions 
can be obtained from the GdalBinaries website.   

 Data folder on network drive: Some users have reported issues when 
processing images stored on network drives. Image data should preferably 
be stored in the default GuidosToolbox\data folder or on a local hard drive. 

 Concurrent use of external software: Opening/processing a raster file in 
GuidosToolbox and simultaneously with an external software (i.e., Erdas, 
ENVI, ArcMap, QGIS) should be avoided. 

 Batch processing under MS-Windows: A MS-Windows system-inherent 
problem will limit the number of files for batch processing (only 32000 
bytes of string can be read). This problem can be alleviated by shortening 
the length for the full path to the image files or bypassed completely by 
using the Linux or the Mac OS X version of GuidosToolbox instead. 

 Undo/Redo: since only one step is saved in the action history the user is 
advised to save intermediate results to the hard drive. 
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